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Office 365:

Tips N Tricks and Shortcuts

Presented by

Greg Creech

Microsoft Certified Application Specialist – Instructor

CompTIA Certified Technical Trainer +

A Nutty Professor!

What’s New Office 365

✓ Welcome Back – Word and PowerPoint

✓ Read Aloud – Word and Outlook

✓ Notes and Comments in Excel

✓ Quick Analysis Toolbar and Flash Fill – Excel

✓ Design Tab – Word

✓ Word’s Collapse and Expand Headings

✓ Task Panes for formatting options, such as Charts, Photos, Text 
boxes, etc.

✓ PowerPoint Slide Master for Themes and Custom Designs

✓ Outlook’s redesigned To-Do Bar

✓ Outlook’s enhanced People view and Calendar preview
404-403-5391 gregcreech.biz 2

1

2



404-403-5391 gregcreech.biz

creechgreg@bellsouth.net 2

Office 365 and OneDrive

✓ Terrific subscription based platform for Desktop, iPad and 

other Tablets, Smartphones, Laptops, etc.

✓ Online Apps and Desktop applications 

✓ Uses OneDrive/SharePoint etc. for storage

✓ Office on Demand for computers without Office

✓ Online Apps not as robust or versatile as desktop apps
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Quick Access Toolbar - Word

✓ Quick Access Toolbar – Saves time by remaining constant 

and retains your favorite commands

➢ Customize for each application

➢ Add commands not in the Ribbon, such as Speak

➢ Show above or below the Ribbon

➢ Quickly add buttons from the Ribbon to the Quick Access 

Toolbar by right clicking the button 

➢ Word – Reveal Formatting, Grow, Speak, and Shrink Font 1 pt
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Quick Access Toolbar - Excel

✓ Customize the Quick Access Toolbar for your favorite 

commands,

✓ Favorite Excel Commands:

➢ AutoFilter (All Commands),

➢ Clear Filter,

➢ Speak Cells (All Commands), 

➢ Sorting and Custom Sort,

➢ Freeze Panes,

➢ Insert Columns and Rows,

➢ Set Print Area.
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Quick Access Toolbar - Outlook

✓ Favorite Commands in Outlook

➢ Search People,

➢ Open in New Window,

➢ Speak,

➢ Outlook Today,

➢ New Items,

➢ Save As.
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Ribbon Display Options

✓ Ribbon Display Options are on the right of your 

Title bar – next to help

✓ Auto-hide takes you to a full screen view and to 

retrieve the ribbon you must click at the top of 

your screen

✓ You may collapse or expand the Ribbon using 

these four methods:

➢ Use the Ribbon Display Options pane

➢ The CTRL + F1 keys

➢ Double clicking the active tab’s title

➢ Right click on a tab for the shortcut menu
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Word

404-403-5391 gregcreech.biz 8

7

8



404-403-5391 gregcreech.biz

creechgreg@bellsouth.net 5

Styles

✓ Attractive and easy to format,

✓ Create your own style or modify your
existing styles,

✓ Select any formatted text and click
the Styles More button and the
menu at right appears for you to 
create your style,

✓ Use your organization’s fonts, 
color palette, etc.,

✓ Save your style settings, especially headings,

✓ Create a theme to use across Microsoft Office and save your 
design for other documents.
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Headings

✓ Part of your Home Tab’s Style Group,

✓ Select your text and apply the Heading in the Styles Group 
gallery,

✓ Use for short title and sections of your document,

✓ Attractive and easy to format,

✓ Adds structure to our document,

✓ Creates an outline for your document,

✓ Table of Contents uses headings,

✓ Expands and Collapses easily.
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Table of Contents

✓ Create your document using Headings 1, 2, 3, and so on,

✓ Reference Tab and Table of Contents Group,

✓ Use a template from the menu or customize  your own 

Table of Contents with leaders and alignments,

✓ Use the Update Table button when your document 

changes or click in the table of contents and press the F9 

key to refresh your table. (TOC do not automatically 

update when changing your document.)
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Word’s Collapse and Expand Headings

✓ Word has a new Collapse and Expand arrow that hides or displays text below 
a heading

✓ Similar to using the Outline view in Word

✓ OOPS! You may accidentally click this arrow and wonder what happened to 
your text – clicking the arrow again expands your heading’s text

✓ The downward pointing arrow collapses/hides your text and the right 
pointing arrow expands/displays your text

✓ Copy/Cut many pages by collapsing the Heading, selecting the Heading, 
copy/cut it, and paste it in a new location; expand the Heading and you’ll 
see that Word copied the heading and ALL of the text, screenshots, etc. with 
it!
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Welcome Back!

✓ Word and PowerPoint have a 

new box when you open a saved 

file that you recently edited

✓ Welcome back allows you to 

return to where you were 

editing your document

✓ Great for quickly navigated from 

the beginning of your file

✓ The dialogue box tells you the 

section where you left off
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Word and PDF

✓ You may open BASIC PDF files in Word for editing

✓ The message above displays important 

information and the conversion may not work well 

for you

✓ When you save a Word file back to PDF you may 

click Options to Password protect the file plus 

other helpful features like Headings as bookmarks
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Word’s Design Tab

✓Word has a new Design tab for using these important 

features:

➢ Creating and using different themes that span the Office 

applications

➢ Inserting Watermarks on your pages

➢ Changing your page colors and page borders

➢ Using Saved color and font schemes

➢ Changing the paragraph spacing quickly
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New! Word’s Learning Tools

✓ Learning Tools is in the 
Immersive Group and the 
View Tab,

✓ This allows the following:

➢ Read Aloud – Word reads you 
selected text for you,

➢ Text Spacing – Hides page 
breaks and headers/footer 
and increases spacing,

➢ Syllables – Separates your text 
into syllables.
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New! Read Aloud and Dictate

✓ Read Aloud (Word and Outlook) – your computer 
speaks your selected text in the document or 
the entire document, (Excel and PowerPoint 
uses Speak),

✓ Settings button offers a menu to adjust voice 
speed and to change the voice,

✓ You may pause, fast forward to or repeat 
paragraphs,

✓ Dictate (Word, Outlook, and PowerPoint)– Allows 
you to speak into your computer and Word 
translates your speech into written text. You 
must be signed into your account to use this 
online service.
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Excel
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Excelling @ Excel: Shortcuts

✓ Navigating and Selection Keyboard Shortcuts

✓ Status Bar and Auto Calculate – Quickly provides SUM, 

AVERAGE, COUNT and other functions based on your 

selection

Keyboard Shortcut What it Does

CTRL + Home Takes you to the top of your worksheet, usually cell A1.

CTRL + End Take you to the end of your worksheet.

PgUp and PgDn Takes you down or up several rows (screen pages) at each press of the key.

CTRL + PgUp and CTRL+PgDn Scrolls through your worksheets or tabs.  CTRL+PgUp Scrolls to the Left for 

you and CTRL+PgDn scrolls to the Right.

CTRL + Shift + Down/Up Arrow Selects an entire column of data/information based on the cell that is 

selected.

CTL + Shift + Left/Right Arrow Selects an entire row of data/information based on the cell that is selected.
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Formulas and Functions

✓ Formulas – we construct formulas using an equal sign (=) and 
then the cell references with the math,
➢ =B5-C5 for a difference

➢ =B6+C10+D12 to add numbers that are not consecutive

➢ =B20*H1 to multiple two numbers

➢ =A5/G1 to divide two numbers

✓ Functions – built in math for you
➢ =SUM(B5:B36) – Adds numbers in this cell range

➢ =AVERAGE (B20,C10,D11,H20) – Averages numbers that are not in a 
continuous range of numbers

➢ =COUNT(B10:B540) – Counts numbers in a range of cells
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Functions

✓ Use the AutoSum button and associated
functions in the menu,

✓ Use Insert Function or the Function Library for
other functions,

✓ Functions:
➢ SUM

➢ AVERAGE

➢ COUNT and COUNTA

➢ TODAY

✓ Quickly use a function by selecting your area you wish to apply 
the funcion and clicking the Sum command button and Excel 
inserts the total at the end of your selection.
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Excel Quick Analysis

✓ Selecting an area produces a shortcut button for 
you to click and receive a menu

✓ The selected area determines how well this 
works for you

✓ Formatting produces Conditional Formatting

✓ Charts creates a selected chart

✓ Totals offers Sum, Average, Count, Percents

✓ Tables produces Format as a table for you and 
aids in sorting and filtering information

✓ Sparklines are quick graphic analytical tools –
similar to a basic chart

404-403-5391 gregcreech.biz 22

21

22



404-403-5391 gregcreech.biz

creechgreg@bellsouth.net 12

Recommended Charts and Shortcuts

✓ Using the Quick Analysis Toolbar and the Charts 
section, you may choose a chart to accompany 
your selected information,

✓ IMPORTANT! Selecting the area or data to base 
your chart upon is critical to receiving a 
helpful chart,

✓ After inserting your chart you may add/delete 
elements, change formatting, and filter your 
information for shortcut keys as displayed 
here,

✓ Shortcut! Select the area for your chart and 
press the F11 (Fn11) key and Excel quickly 
creates a column chart in another worksheet 
for you!
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Excel Magic - Flash Fill

✓ Completes series for you – Combines AutoComplete 

and Text-to-Columns features for you with the magic 

of Fill

✓ Great for text, text as numbers, dates, and so on

✓ Insert a column, enter a couple of items, and Excel 

produces a “gray” list of items it believe you want 

to use – press enter to accept the Flash Fill

✓ Use the Fill Handle to produce the Flash Fill option 

in the Fill Handle option for you list

✓ You may need to format the column as text
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New! Excel Comments and Notes

✓ Comments have changed to Notes in Excel,

✓ A new Task Pane makes reading and replying to 

notes easier and more visible,

✓ Very helpful when sharing a workbook,

✓ Notes works as Comments did,

✓ The Notes button in the Review Tab offers a menu 

to navigate through your notes, show/hide your 

notes, delete, edit, and add Notes,

✓ A cell may not have a Note and a Comment,

✓ The shortcut menu has changed with New 

Comment or New Note.
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PowerPoint

404-403-5391 gregcreech.biz 26

25

26



404-403-5391 gregcreech.biz

creechgreg@bellsouth.net 14

Animation Tab

✓ Add appropriate animation to bullet list, titles, graphics, 
and much more in PowerPoint,

✓ Use the animation tab to choose your animation from the 
gallery,

✓ Set your animation to activate on click, with previous, or 
after previous,

✓ Duration is the length of the animation which you may 
increase or decrease the time,

✓ Delay is the time in between your animations which you 
may increase or decrease the time.
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Animation Pane

✓ Use the Animation Pane to

➢ Change the order of your animation,

➢ Right click on an item in your pane or click the 

drop down arrow for a list of options,

➢ Remove the animation,

➢ Add functionality to your animation, such as 

dimming bullet items through Effect Options.
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Animation Painter

✓ Similar to Format Painter,

✓ Copies animation from object to 
another object,

✓ Select the object that you wish to copy 
and click the Animation Painter,

✓ Next, click the object that you wish to 
use the animation,

✓ Double click the Animation Painter to 
paste multiple objects,

✓ Press ESC key or click the Animation 
Painter button again to stop pasting. 
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Transitions Tab

✓ Animation is movement within a slide,

✓ Transition is movement between slides,

✓ Similar to animation you choose a transition and use Effect Options,

✓ You may change the speed of your transition using the Duration box,

✓ You may use the same transition for your presentation (using the 
Apply To All button)or use different transitions for each slide,

✓ Like animation, you may activate your transition on a mouse click or 
automatically move through the slide(s) using the After box.
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SmartArt in PowerPoint

✓ You may add SmartArt for diagrams to PowerPoint using the 

Insert Tab or the Content pane for some of the layouts,

✓ SmartArt has many types of diagrams, charts, and graphics, such 

as Pyramid, Cycle, Hierarchy,

✓ You may use the Text Pane or type directly into the SmartArt 

objects to enter text,

✓ Use SmartArt’s Design and Format tabs to change your layout, 

colors, and other items to enhance your diagram.
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My Sales Cycle
Meet and 
Greet The 

Client

Data Gather

Make 
Proposal

Schmooze & Booze 
The Client

Close the Sale or 
Choke the Client!

Celebrate!

Repeat if 
necessary 
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Themes

✓ Themes work across the Office applications,

✓ Built in Themes,

✓ You may save your custom font and color schemes as 

Themes to use in other applications,

✓ Themes are in your Design or Page Layout Tabs,

➢ From the menu choose Save Current Theme.
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Design

✓ Highly customize PowerPoint presentations through 

Design Tab and the Slide master,

✓ Use PowerPoint and Microsoft Office for branding your 

organization,

✓ Include your logos, color palette, fonts, and other style 

sheet specifications on all of you presentations and 

documents,

✓ Create your own Color and Font schemes and save as a 

Theme to work across all Office applications.
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Font and Color Schemes

✓ Using Slide Master or the Design Tab you may create 

your own Color and Font schemes to use in your 

presentation,

✓ Ensures consistency,

✓ Great for branding your organization,

✓ Highly customize your colors to match your RGB 

numbers,

✓ Save as a Theme allows the design to work in other 

Office applications.
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PowerPoint: Slide Master and Themes

✓ Customizing and creating Themes in the Slide Master, too, effects all 

or certain slides and layouts

✓ Streamlined Design tab with Themes, changing Color/Fonts and 

Backgrounds plus saving a theme

✓ You should use Slide Master and Themes, Colors, Fonts to create a 

custom template and design for your slides and layout

✓ Save your theme to reuse on new and existing presentations
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Our Newest Associate

Video Example
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Outlook
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To-Do Bar Enhancements

✓ The To-Do bar is in the View tab and activates for each 

Outlook object - Mail, People, Calendar

✓ You may set different options for each Outlook object to 

view Calendar, People, or Tasks

✓ The To-Do bar offers an At-A-Glance look of your calendar 

appointments, people, and tasks

✓ You may quickly open an item by double clicking

on it

✓ You may navigate to different months with your

calendar displayed
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Categories

✓ Categories organize Outlook items using color 
and text,

✓ You may categorize any Outlook item,

✓ You may create your own categories using color 
and text to keep you organized,

✓ One Outlook item may have several categories,

✓ Views and the View Tab in Outlook provides 
terrific views by category.

✓ Color codes  your calendar. 
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Email Conversations aka Thread

✓ A popular view in email systems 
(Yahoo, iPad, Gmail, etc) is 
threads called Conversations in 
Outlook

✓ Conversation View activates from 
the View tab and has these 
options for you to choose:
➢ Show messages from other folders

➢ Show senders above the subject

➢ Always expand selected 
conversation

➢ Use classic indented view
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Calendar Previews and Weather

✓ Calendar views contain a quick glance for 

the weather at locations you select as 

displayed here you may Add Locations

✓ Besides Outlook’s preview on your 

calendar when you hover your cursor over 

an appointment a fly out pane displays 

the appointment for you in Week, Work 

Week and Month views
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People and Quick Access

✓ Outlook refers to Contacts as People in the 

Folder or Navigation Pane

✓ Add Search people to your Quick Access Toolbar 

for quick access to your contacts

✓ After clicking the person in your search list, 

Outlook provides a preview of the person’s 

information from which you may perform many 

actions and edit the contact’s information

✓ Add People to your To-Do bar to locate your 

contacts using the To-Do bar across Outlook 

objects
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Thank you!

✓ Thank you –everyone! You are the best,

✓ Enjoy Atlanta and your fabulous 

conference,

✓ OK – One Unabashed, shameless, self-

promotion slide!

✓ I appreciate you and the work you do,

✓ gregcreech.biz or gregcreech.com

✓ 404-403-5391

✓ Thanks for our time!
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